
Working with Blender for 3D Printing

Blender is a very powerful open source graphics package primari ly designed for modeling to produce rendered sti l l

images and animations. I t also al lows users to produce accurately dimensioned models for 3D printing. The

Blender development community has recognised this and the latest editions now include a suite of tools for

checking the models produced to ensure they are print-ready.

Where to get Blender
Blender is free to download and can be obtained from the website below.

http: //www.blender.org/

On the CD you have been provided with you wil l find versions 2.71 and 2.72 for 32 bit Windows and Linux. I f you

would l ike Mac versions or 64bit versions you wil l need to go to the Blender website to download them. The

Windows versions are either zipped-up self-contained instal lations which do not need to be instal led, or as a self-

instal l ing .exe.

A Special Thing to Remember

When using Blender

A word of warning about Blender: Blender wil l

NOT ask you if you want to save before it shuts

down. Make sure you save your work before

shutting down the application. The latest version

does ask you if you are sure you want to quit so

this does allow for second thoughts.

Setting up Blender
Blender's default settings are sl ightly unhelpful for 3D modeling, particularly if you are used to other modeling

packages. The instal lations we are using for the workshop have already been set up; but, should you wish to set up

an instal lation at home, here are the suggested changes:

Open the “User Preferences” window by

clicking on the File Menu at the top of the

Blender Window and selecting the User
Preferences option.



Select the “Addons” tab and scrol l down unti l
you find the “3D View: Dynamic SpaceBar
Menu”. Tick the box to the right. While this is

not necessary to enable you to build objects in

Blender, it is a useful addition.

Now when you hit the Space Bar when the
cursor is in the 3D View, a menu wil l pop up that

al lows you to add objects, manipulate them and

do a whole host of other things.

Down at the bottom of the User Preferences window you wil l find a “Save User Settings” button. Click on this to
save the modifications you have made so that these wil l be your settings when you next run Blender.

As a default, Blender only al lows you to select the vertices on the surfaces of an object that are facing you when in

the Edit Mode. This is not particularly helpful if you are trying to select the whole top surface of a cylinder from a

side view for instance. To change this, do the fol lowing:

Select the “Input” tab and click on the “Left” button under
the “Select With:” option. This means that to select an
object, vertex, edge, or face, you wil l use the left mouse

button.

This wil l make the method for selecting items consistent

with most other 3D modeling and animation packages.

With the default cube selected, hit the Tab
button to enter Edit Mode.
At the bottom of the 3D window you wil l find

a picture of a cube with big vertices on one

of the buttons. I t wil l have a dark

background as shown in the image to the

right. Click on this button to deactivate it.



I t should now have a light grey background

as shown in the image to the right. The

default cube in your scene should now have

the vertices on the back corners visible.

Go to the File menu at the top of the screen

and select “Save Startup File”. Once you
have done this, the settings we have just set

wil l be automatical ly loaded each time you

start Blender.

Adding Things
General ly al l Blender 3D printing models start from a handful of basic shapes such as cubes, cyl inders, and

occasionally curves. There are two main routes for adding an object to your model. Use the space bar pop up

menu, or the “Add” menu at the bottom of the 3D window. If you want the shape to be added to an existing shape,

then you can add them when you have the original shape open in Edit Mode.



Some shapes have the

option of setting the basic

dimensions when you add

them. The dialogue in the

left hand panel is where

you wil l find this. Al l

dimensions in Blender are

in mm. This is real ly

handy for exporting the

models for printing as it

al lows us to define the

exact sizes we are after.

Modifying Things
Once you have a basic shape in the 3D workspace, you can modify it in many ways to achieve the shape you are

after. These include; moving, rotating, scaling, deleting, fi l l ing, and extruding shapes, vertices, edges and faces.

Subdividing edges and faces and merging vertices are also useful tools. You can also add, subtract, and intersect

objects but this can lead to some odd artifacts appearing in your mesh that wil l need cleaning up before it can be

printed rel iably.

Manipulating faces and vertices

Click on the vertex, edge or face you want to change. I f you want to select more than one face or vertex, hold the

shift key and select each additional one by clicking on them, or use the box select by hitting the "b" key and drawing

a box around the items you wish to select.

Say you wanted to move a vertex, the fol lowing method using keyboard shortcuts is one method to achieve this:

Hit “g” and drag the item in the direction you want to go.

I f you wish to move it only in the X, Y, or Z direction just key in “gz” to constrain the

movement in the z-direction, or “gx' for the x-direction.

I f you wish to move it a specific distance just key in the direction shortcut and the

number of mil l imeters you wish to move it. For instance, the shortcut “gz5.2” wil l move

the item 5.2mm in the z-direction.



A wireframe view can be useful for

viewing complex shapes and how

they might be fitting together.

The same applies for scale and rotation.

For a scaling operation you would key in something l ike “s4” to make something four

times the size or “sy0.5” to scale something 50% in the y-direction.

For rotations, “rx45” wil l rotate the selected item 45º around the x-axis.

I f you do not wish to use the shortcuts, you can use the buttons in the top of the left hand panel, or the three buttons

in the middle of the small panel immediately below the 3D window next to where it says “Global”. Using these

buttons wil l change the handles on the object to indicate the type of action. In the image below the handles are the

blue, green, and red arrows in the centre of the selected face. Clicking and dragging these handles wil l move the

object.

Filling areas

I f you wish to join two vertices or fi l l the space between three or four vertices, select them and hit the “f” key. I f you

have an empty area bounded by a edges, select al l of the surrounding edges (sometimes selecting an Edge Loop
from the “Select” menu at the bottom of the 3D Window wil l al low you to easily select al l of the edges), and then hit

Alt+f to fi l l the area.



Handy Keyboard Shortcuts
Here is a diagram of the most useful shortcut keys. Having a ful l keyboard makes life a lot easier for view control.

Tutorials on Blender
There are a large number of tutorials on using Blender. Unfortunately most of the pdf tutorials are for older versions

of Blender, you wil l most l ikely have to use video tutorials for the latest versions. General ly a tutorial for blender

versions 2.5 or greater wil l be valid for what you are using at the moment.

Hutt City Libraries also have free access to lynda.com where you can find a number of Blender tutorials.



Glossary
Artifacts

Sometimes a digital model is of a poor quality and when “sl iced” to produce the “gcode” it can produce unwanted

features, layers, and other random “scribbles”. These errors are called “artifacts”.

ABS

Acrylnitri le-Butadien-Styrene – A particularly tough plastic commonly used in children's toys and Lego. I t has a

relatively high melting point compared to the more common PLA (see below) and because of its tendency to shrink

as it cools can be quite challenging to print.

Arduino

An Open-Source microcontrol ler that is the heart of most 3D printers that are on the market at present. I t is a

programmable device capable of taking measurements with a range of sensors, control l ing motors, and interfacing

with a computer.

Engine

In the software context this is a dedicated piece of software or code that does the hard mathematical work

calculating out something l ike the tool paths that the 3D printer extruder wil l need to fol low to create the desired

shape.

Extruder

The part of a 3D Printer that produces the l ine of molten plastic as the Printer builds the object. Typical ly the

extruder is a fine nozzle with a heater and a device to force the fi lament into the heater and nozzle.

Extrusion Printer

These are the most common type of 3D Printer available for the home or small workshop. These printers use an

extruder to lay down layers of molten plastic to produce the object.

Filament

All 3D Printers on the market for home and small workshop use a spool of plastic fi lament as the “raw material” from

which the objects are built. The fi lament is passed into the extruder which melts it and exudes it as a fine stream of

molten plastic into the object being made. The fi lament looks a bit l ike a spool of weed-eater nylon (and people

have used weed-eater nylon as 3D Printer fi lament).

Fill

The fi l l is an expression for the amount of material used to fi l l the interior of an object. A 1 5% fil l means that the

interior of the object is 1 5% plastic and all the rest is air.

Fill Pattern

In order to achieve the desired density of fi l l the user can define a type of pattern to use; this might be “hexagonal”

to give a honeycomb fi l l pattern, or “recti l inear” to give a cross hatch fi l l pattern.

gcode

When a model is “Sl iced” the program works out what movements the 3D Printer extruder must do in order to create

the shape for that layer. I t writes these instructions into a gcode fi le. The gcode fi le could conceivably be read by a

person because it is just a series of directions and measurements.

Handles

When working in graphics programs such as Blender, you may find a series of three coloured arrows appear

whenever something is selected. These are called “Handles” and dragging on them wil l change the selected item(s)

in some way in the direction of the handle you have dragged on.

Handworking Techniques

Working the old fashion way with hands and tools.

Laser cutting

Laser cutting and CNC mil l ing are both complementary technologies to 3D printing where a laser or a router are

guided around a shape to cut it out of a sheet of wood, plastic or metal.

Mesh

In the context of 3D modeling a “mesh” is the digital shape created within a 3D modeling computer package. The

name derives from the fact that a mesh is a series of points joined by lines to describe the object's surface.



Microcontroller

An electronic device that can be programmed to do a variety of sophisticated tasks. They are not as complex as a

computer but are able to interface with computers and with hardware such as motors, relays, etc.

Moderated

In the context of 3D Model websites this means that the models submitted are not checked by the website owners

and operators.

OBJ

A common 3D Model format. Most 3D printer software can handle this format. I t appears to be becoming the

standard for multiple extruder printers because the OBJ format can carry colour information.

Open Source

Open Source means that the underlying code and intel lectual property is available to be picked up by anyone

wanting to develop it further, improve it. This means it cannot be patented and depending on the nature of the

l icense it must only be distributed for free. Obviously there is a lot more to it than that and I would encourage you to

look it up on the web as well as look at the Creative Commons License which is strongly associated with it.

PET

Polyethylene-Terephthalate. This is the same plastic in 1 .5L soft drink bottles.

PLA

Polylactic Acid. A starch based bioplastic. This is the same plastic in supermarket bags and is the most common 3D

Printing fi lament. I t is a well behaved plastic with good 3D printing characteristics and moderately good strength.

Plugin

In the software context a plugin is a small bit of extra software you can add to some existing software to extend its

functionality.

Reprap

The Reprap is the open source 3D Printer that is the original “parent” of most of the home and small workshop type

printers available on the market at present. There are quite a few different variations. You can find al l the

instructions and fi les to build your own on the www.reprap.org website.

Slicer

A program for analysing 3D Digital models to develop the gcode that wil l guide the 3D printer as it creates the

object.

Slicing

The term used to describe the process that a Slicer goes through to analyse a 3D digital model by considering it as

a series of sl ices with a perimeter and the interior of the shape defined by the perimeter fi l led with a pattern that the

program determines based on the amount of “fi l l ” it has been told to achieve.

STL

This is the common format used for 3D Models and the 3D Printer software. This format does not carry any colour

information.

Tool path

This is the l ine, and shapes that a printer extruder wil l fol low in order to create the object. The gcode describes

every step in the tool path.

Wireframe

In 3D modeling packages it is sometimes useful to make the faces on the model invisible. The view of the object

then looks a little bit l ike it was made out of bits of wire describing the surface of the object – thus wireframe model.

As it is just a way of viewing the model doing this does not affect the model itself and the view can be changed to

show the faces again.
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